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Abstract:

The Telelogic product DOORS has provided its users with a comprehensive set of functionality
to manage Requirements across the Enterprise.  To further extend the capability of DOORS and
allow users to customize the product to meet their specific needs, the makers of DOORS have
provided a powerful Application Programmer Interface (API) called the DOORS Extension
Language (DXL).  This API gives the user access to the internal DOORS functionality, and
unlocks the power of the tool beyond those functions present from the user interface.

The Telelogic product DOORS also surpasses the competition in its ability to add Rich Text
Markup (including font markup, OLE Objects and pictures) to requirements documents.

Details of programmatic manipulation of Rich Text Markup in the DOORS database using DXL
will be discussed, including:

(1) Detecting, adding and deleting Rich Text Markup contained in attribute text.
(2) Displaying Rich Text Markup in Layout DXL columns.
(3) Manipulating and removing embedded font markup.
(4) Differences between Rich Text Markup schemes in DOORS v5 and DOORS v6
(5) Implications of Rich Text Markup with regards to Importing from and Exporting to

Microsoft Office applications.

Through the knowledge and application of DXL and Rich Text Markup, these needs can be
addressed.
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DOORS 4.0 - Introduction of Rich Text

With the release of DOORS 4.0, QSS (now Telelogic) introduced Rich Text editing into the realm of requirements
management, giving users word processing style features for control over font style and effects.

When editing text in a DOORS Object, portions of the text can be highlighted, and Rich Text can be applied to the
highlighted text by choosing the desired font effect from the right-click menu, the toolbar, or entering a key
combination.  Note:  No key combinations are available for superscript and subscript.

Ctrl+Shift+B Makes current selection bold
Ctrl+Shift+I Makes current selection italic
Ctrl+Shift+S Makes current selection strikethru
Ctrl+Shift+U Makes current selection underlined



Telelogic 2003 User Group Conference – Americas and Asia/Pacific
DOORS Rich Text - Behind the Markup v1.1

© 2003 Galactic Solutions Group LLC Page 3
Author: Michael Sutherland
michael.sutherland@galactic-solutions.com

Rich Text Markup - Overview

Markup refers to a sequence of character symbols (often called "tags") that are inserted into a data file or string to
indicate how the data should be rendered or formatted when it is printed or displayed.  One example of a markup
language that does this is the HyperText Markup Language (HTML), a World Wide Web Consortium (W3C)
specification for interoperable technologies.

Markup can also describe the structure of a data file, encoding a description of the document's storage layout and
logical structure.  One example of a markup language that does this is the Extensible Markup Language (XML),
another World Wide Web Consortium (W3C) specification for interoperable technologies.

Rich Text Markup - DOORS 4 and above
In DOORS 4, support for simple Rich Text Markup such as font style and font effects (bold, italic, etc.) was added.

Documented Markup Tag Strings
Font Effect On Off
Bold "{\\b " "}"
Italic "{\\i " "}"
Underline "{\\ul " "}"
Strikethru "{\\strike " "}"
Superscript "{\\super " "}"
Subscript "{\\sub " "}"

"{\\nosupersub " "}"

Note:  The backslash character '\' is an escape character in strings, meaning "\\" = '\' , so the table
above lists the proper string version of the tags as needed for programmatic use in Rich Text strings.  A printed

version of the string shows the desired result, which is the single backslash character '\'.

The syntax for using these tags within a string is as follows:

{tag<space>text} or {tag{text}}

The space character before the closing quote for "On" tags is mandatory, unless the tag is immediately followed by
an opening brace character.  A closing brace character turns off all markup nested between it and the previous
opening brace character.

Tags can be nested, to apply more than one type of formatting, as follows:

{tag<space>text{tag<space>text}}

Example:  Create the following Rich Text Formatted text:

Bold Italic BoldandItalic

The following three examples show Rich Text Markup strings that will achieve the desired result:

“{\\b Bold} {\\i Italic} {\\b {\\i BoldandItalic}}”
“{\\b{Bold}} {\\i{Italic}} {\\b{\\i{BoldandItalic}}}”
“{\\b Bold} {\\i Italic} {\\b \\i BoldandItalic}”

http://www.w3.org/MarkUp/
http://www.w3.org/
http://www.w3.org/XML/
http://www.w3.org/
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DXL to set and display Rich Text strings – DOORS 4 thru 5
DOORS 4 thru 5 – Setting Rich Text Markup from the DOORS Graphical User Interface (GUI)

DOORS "Object Text" with Rich Text Markup

DXL to show Rich Text Markup string for DOORS "Object Text"

DOORS 4 thru 5 – Setting Rich Text Markup via DOORS DXL

DXL to set DOORS "Object Text" with a Rich Text Markup string

Resulting DOORS "Object Text" with Rich Text Markup
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DOORS 4.1 - Updates

New "Support Tools" added to the Tools menu of DOORS Formal Modules with the release of DOORS 4.1.
<standard/doctools/normmark.dxl> "Remove Unsupported Markup"

This function removes all unsupported markup from all
string and text attributes on all visible objects.

Note: Uses removeUnlistedRichText()
<standard/doctools/delmark.dxl> "Remove All Markup" (Rich Text mark-up Deletion Tool)

This function removes all markup (bold, italic etc.) from all
string and text attributes on all visible objects.

Note: Uses o.attrname = o.attrname "" and
deleteFontTable()

<standard/doctools/symbconv.dxl> "Convert Symbols to Text" (Symbol to Plain Text Conversion Tool)
This function converts symbols and other nonstandard character sets
into the user's system default character set.

Note:  Uses "for rt in s do" {}

DOORS 5.0 - Minor Updates

DOORS 5 introduced no significant changes in Rich Text Markup structure and functionality.
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DOORS 6.0 - Major Update
With the release of DOORS 6.0, Telelogic adopted the Microsoft Rich Text Format (RTF) Specification (or some
reasonable subset thereof).  The Microsoft Rich Text Format is a metafile standard developed by Microsoft to
encode formatted text and graphics for transfer between applications.

Note: It is a common misconception that Rich Text Format is a World Wide Web Consortium (W3C) specification
for interoperable technologies.  It is not.

Telelogic, believing that all of the legacy problems with unsupported markup were eliminated, removed the support
tools from the Tools menu.

"Support Tools" removed from the Tools menu of DOORS Formal Modules with the release of DOORS 6.0.
<standard/doctools/normmark.dxl> "Remove Unsupported Markup"
<standard/doctools/delmark.dxl> "Remove All Markup" (Rich Text mark-up Deletion Tool)
<standard/doctools/symbconv.dxl> "Convert Symbols to Text" (Symbol to Plain Text Conversion Tool)

http://www.w3.org/
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DXL to set and display Rich Text string – DOORS 6
DOORS 6 – Setting Rich Text Markup via DOORS DXL.

DXL to set and show resulting Rich Text Markup string for DOORS "Object Text"

Resulting DOORS "Object Text" with Rich Text Markup shown.

Note extra "\" characters in the version of the Rich Text Markup string printed from DXL.  In DOORS 6, printing
the opening or closing brace characters ( "{" or "}" ) or a backslash "\" results in an extra backslash
character being displayed in the printed output as follows:

This is a known bug in DOORS 6.x that has been fixed in DOORS 7.
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DOORS 6 – Setting Rich Text from the DOORS Graphical User Interface (GUI).

DOORS "Object Text" with Rich Text Markup

DXL to show Rich Text Markup string for DOORS "Object Text"

Microsoft Rich Text Markup is inserted (with extra '\' characters preceding each brace and backslash character in the
printed Rich Text Markup string).

Note: No documentation on Microsoft Rich Text Markup, or how it is used, is available from Telelogic.
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Rich Text Markup - DOORS 6 and above
The encoded data is called a RTF code stream, which consists of fields called control words (formatting and printing
instructions), control symbols (escape character sequences), and groups (enclosed in brace ({}) characters).  Each
field begins with a backslash (\) character.

Object Heading - Default Markup (for non-empty Object Heading)

\{\\rtf1\\ansi\\ansicpg1252\\deff0\\deflang1033\{\\fonttbl\{\\f0
\\fnil\\fprq1\\fcharset0 Arial;\}\} \{\\colortbl
;\\red0\\green0\\blue0;\} \\viewkind4\\uc1\\pard\\cf1\\f0\\fs28
\\par \}

Object Text - Default Markup (for non-empty Object Text)

\{\\rtf1\\ansi\\ansicpg1252\\deff0\\deflang1033\{\\fonttbl\{\\f0
\\fnil\\fprq1\\fcharset0 Times New
Roman;\}\{\\f1\\fnil\\fprq1\\fcharset0 Century Schoolbook;\}\}
\{\\colortbl ;\\red0\\green0\\blue0;\}
\\viewkind4\\uc1\\pard\\cf1\\f0\\fs20  \\f1\\par \}
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Detailed explanation of Microsoft Rich Text Markup

The control codes \rtf1\ansi indicate that this data stream is an RTF document, that the code conforms to
version 1 of the RTF specification, and that the document uses the ANSI (\ansi) rather than the PC (\pc), PS/2 (\pca),
or Macintosh (\mac) character sets.

The \fonttbl group contains the descriptions of the fonts used within the document.  The fields are Font
Number (fn or fnnnn), Font Family (see below), and Font Name.

Control word Font family
\fnil Unknown or default fonts (default)
\froman Roman, proportionally spaced serif fonts (TmsRmn, Palatino, etc.)
\fswiss Swiss, proportionally spaced sans serif fonts (Swiss, etc.)
\fmodern Fixed-pitch serif and sans serif fonts (Courier, Elite, Pica, etc.)
\fscript Script fonts (Cursive, etc.)
\fdecor Decorative fonts (Old English Zapf Chancery, etc.)
\ftech Technical, symbol, and mathematical fonts (Symbol, etc.)

The \colortbl group is a color table used to control screen and printer colors. This file defines a basic palette
of 16 colors, with each color channel containing an 8-bit index value in the range of 0 to 255.

The \viewkind control word is an integer (0-5) that represents the view mode of the document, corresponding
to the views available in Microsoft Word:

RTF None \viewkind0
RTF Normal \viewkind4
RTF Outline Layout \viewkind5
RTF Page Layout \viewkind1
RTF Outline \viewkind2
RTF Master Document \viewkind3

The \uc1 control word represents the number of bytes corresponding to a given \uN Unicode character.

The \pard control word resets to default paragraph properties.

The  \cf1 control word specifies the foreground color.

The \fN control word Font number. N refers to an entry in the font table.

The \fsN control word specifies the font size in half-points.

The \par control word specifies a new paragraph.
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Rich Text Markup - Font Effects in DOORS 6
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Rich Text Markup - New Font Effects in DOORS 6

In DOORS 6, Rich Text Markup for the bulleting and indenting of paragraphs is supported.



Telelogic 2003 User Group Conference – Americas and Asia/Pacific
DOORS Rich Text - Behind the Markup v1.1

© 2003 Galactic Solutions Group LLC Page 13
Author: Michael Sutherland
michael.sutherland@galactic-solutions.com

DOORS 6 - Rich Text Markup for Bullets

The \pntext group precedes all bulleted or numbered paragraphs, and will contain all the text and formatting
that would be auto-generated as plain text to provide compatibility with existing RTF readers.

The \* control word marks a destination whose text should be ignored if not understood by the RTF reader.

The \pn destination control word turns on paragraph numbering.

The \pnlvlblt control word designates a bulleted paragraph (corresponds to level 11). The actual character
used for the bullet is stored in the \pntxtb group.

The \pnfN control word specifies a font number.

The \pnindentN control word specifies the minimum distance from margin to body text.

The \pntxtb destination control word contains the text that precedes the number.
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DOORS 6 - Rich Text Markup for Indents

The \liN control word specifies a left indent level, in Twips.  A Twip is twentieth of a Point (1/1440th of an inch
or 1/567th of a centimeter).  A Point is approximately 1/72nd of an inch.  Twips are used because they are a screen-
independent unit, which can be adjusted in size as screen resolution is changed, but also express an absolute value
for printing (unlike pixels).

In DOORS 6 and above the base unit of indentation in DOORS 6.0 is 360 twips, so values of the left indent level
will be multiples of 360.

In DOORS 7, the applyTextFormattingToParagraph() command was introduced to allow the
application of bullets and indents to paragraphs through a single DXL command.  In DOORS 6, the only way to
programmatically add bullets and indents is to comprehend and apply detailed knowledge of Microsoft Rich Text
Markup and string manipulation.
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DOORS 6 - Rich Text Markup for OLE Objects
In DOORS 6 and above, OLE Objects are stored as Rich Text Markup data in Text Attributes (such as "Object
Text".

Example:  Insert -> OLE Object (from file
$DOORSHOME\lib\dxl\standard\suspect\indicate\suspect_in.bmp).

Note:  Major chunks of the image data in the above example have been replaced by "…", for brevity.

The \object control word indicates an OLE Object.

The \objemb control word indicates an object type of OLE embedded object.

The \objclass control word allows for a text argument that specifies the object class to use for this object and
ignores the class specified in the object data.

The \objwN and \objhN control words specify the original object height in twips, assuming the object has a
graphical representation.

The \objdata subdestination control word contains the data for the object in the appropriate format; OLE
objects are in OLESaveToStream format.

The \result optional control word contains the last update of the result of the object (a \pict (bitmap)
snapshot of the OLE Object).
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Application - Rich Text Markup and Layout DXL - Setup

DOORS 4.0 and above allows Rich Text Markup for Font Effects to be displayed in a Layout DXL column.  This
can help make traceability columns more readable.

Example:  Take the output from the DOORS Analysis->Wizard and add Rich Text bolding to the Attribute names.

Use the Analysis -> Wizard to generate Layout DXL:



Telelogic 2003 User Group Conference – Americas and Asia/Pacific
DOORS Rich Text - Behind the Markup v1.1

© 2003 Galactic Solutions Group LLC Page 17
Author: Michael Sutherland
michael.sutherland@galactic-solutions.com

Application - Rich Text Markup and Layout DXL - Results

Layout DXL as generated by the Analysis Wizard Layout DXL modified to display attribute name in bold.

Resulting Layout DXL Display Columns (original and modified)



Telelogic 2003 User Group Conference – Americas and Asia/Pacific
DOORS Rich Text - Behind the Markup v1.1

© 2003 Galactic Solutions Group LLC Page 18
Author: Michael Sutherland
michael.sutherland@galactic-solutions.com

Application – Rich Text and History Markup

A script is included with DOORS 6.0 that uses Rich Text Markup to show changes to “Object Text” with respect to
some original version (from a Baseline, etc.).

$DOORSHOME/lib/dxl/example/histcol.dxl
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Application - Rich Text Traceability

DOORS 6.0 and above allows the complete set of Rich Text Markup (including OLE objects and Pictures) to be
displayed in a Layout DXL column.  This allows complete traceability reporting to requirements residing in or
supported by graphic objects.

Example:

When using the Analysis -> Wizard to create Layout DXL Column, make sure “Include OLE objects in text” is
selected in Step 5.

The result is a Layout DXL traceability column that displays Rich Text (including OLE Objects).

The following Layout DXL shows how the “displayRich” and “richTextWithOle” commands are used to achieve
Rich Text Traceability.
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DOORS Font Table - Module Level Attribute

When information from Microsoft Word or RTF documents is imported into a DOORS Module, a Module level
attribute called "Font Table" may be created and populated with non-default font table entries.  The DOORS DXL
manual states that these entries are “used for mapping richtext font markup to character set information to override
embedded font markup.”

DOORS default font table is:

{\f1012\fswiss\fcharset177 Arial;}
{\f1011\fswiss\fcharset162 Arial;}
{\f1010\fswiss\fcharset238 Arial;}
{\f1009\fswiss\fcharset204 Arial;}
{\f1008\fswiss\fcharset161 Arial;}
{\f1007\fswiss\fcharset0 Arial;}
{\f1006\froman\fcharset177 Times New Roman;}
{\f1005\froman\fcharset162 Times New Roman;}
{\f1004\froman\fcharset238 Times New Roman;}
{\f1003\froman\fcharset204 Times New Roman;}
{\f1002\froman\fcharset161 Times New Roman;}
{\f1001\ftech\fcharset2 Symbol;}
{\f1000\froman\fcharset0 Times New Roman;}
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Rich Text and Importing from Microsoft Office Applications

Since DOORS 4.1.4 SR2 (and perhaps earlier), DOORS has included embedded font information when importing
from Microsoft Word.  The following example data was generated by importing a Microsoft Word document into
DOORS 4.1.4 SR2.

Example Font Table created from data imported from Microsoft Word:

{\f3\froman\fcharset2\fprq2 Symbol;}
{\f2\fnil\fcharset2\fprq2 Monotype Sorts;}
{\f1\fswiss\fcharset0\fprq2 Arial;}
{\f0\froman\fcharset0\fprq2 Times New Roman;}

Example Imported Font Style Markup imported from Microsoft Word:

{\f1007 }
{\f1007 \f1 }
{\f1 }
{\f1007 \f1 \f1001 ±\f1 }

Example Imported Font Effects imported from Microsoft Word:

\b \b0 \ul \ul0 \i

Note: This demonstrates that DOORS, since version 4.0, has always imported and supported (without conversion) a
limited amount of Microsoft Rich Text Markup.  This is not documented in the DOORS manuals.

Documented Markup Tag Strings Alternate, Undocumented Markup Tag Strings
Font Effect On Off On Off
Bold "{\\b " "}" "\\b " "\\b0 "
Italic "{\\i " "}" "\\i " "\\i0 "
Underline "{\\ul " "}" "\\ul " "\\ul0 " or "\\ulnone"
Strikethru "{\\strike " "}" "\\strike " "\\strike0 "
Superscript "{\\super " "}" "\\super " "\\super0 " or

"\\nosupersub "
Subscript "{\\sub " "}" "\\sub " "\\sub0 " or

"\\nosupersub "
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Rich Text Markup - Normalization in DOORS 6

The DOORS 5 Manual states: "In versions of DOORS prior to 4.1, the DOORS import tools imported rich text
markup that wasn’t supported by DOORS. DOORS now only imports supported rich-text markup, and discards
markup that it doesn’t support."

Now that DOORS 6 and above has implemented the Microsoft Rich Text Format (RTF) standard more fully, some
of this markup that was previously suppressed may reemerge when DOORS 5 data is converted to DOORS 6.  In
particular, font markup may appear to be "non-standard" with regards to Fonts.

Note:  Font markup has always been supported, and has never been suppressed.

The solutions recommended by Telelogic are:

(1) "Remove Unsupported Markup" (attempt to remove only unsupported markup)
(2) "Remove All Markup" (strip out all Rich Text Format, leaving raw text with no formatting)

These functions first provided in DOORS 4 and available in DOORS 5 were not released with DOORS 6.
Attempting to use them results in less than desirable results.  Solutions (1,2) does not preserve Symbol Font
characters, and leaves unwanted Font style information.  Solution (2) is not acceptable because valid markup must
be preserved.

In DOORS 5, deleting the contents of the Module level "Font Table" attribute eliminated some non-standard fonts
from appearing.  In DOORS 6, this does not seem to have the same effect.

The requirements for the desired normalization are:

(1) All Font Markup shall be eliminated for Object Heading and Object Text Attributes, except:

(a) Symbol Font characters shall be preserved.

(2)  Valid Rich Text Markup (bold, italic, strikethru, underline, superscript, subscript) shall be preserved.

(3) Object Text with embedded OLE, bullet, or indent markup (new features in DOORS 6) shall not be modified.



Telelogic 2003 User Group Conference – Americas and Asia/Pacific
DOORS Rich Text - Behind the Markup v1.1

© 2003 Galactic Solutions Group LLC Page 23
Author: Michael Sutherland
michael.sutherland@galactic-solutions.com

Rich Text Markup - Normalization in DOORS 6 - Algorithm:

Use a "for rt in s"  loop to scan the existing Rich Text string "chunk" by "chunk" for valid markup.  This
method has the benefit of ignoring any invalid markup.  A new version of the Rich Text string is built by taking each
successive chunk of formatting and reapplying the valid markup to the plain text version of the string.

// s is Rich Text string
string s = richText( o."Object Text" )

Buffer richBufferNew = create

RichText rt
for rt in s do {

string text = rt.text
string markupPrefix = ""
string markupSuffix = ""
if ( rt.bold ) {

            markupPrefix = "{\\b " markupPrefix
            markupSuffix = markupSuffix "}"

}
if ( rt.italic ) {

            markupPrefix = "{\\i " markupPrefix
            markupSuffix = markupSuffix "}"

}

…….
if ( rt.charset == charsetSymbol ) {

            markupPrefix = markupPrefix "{\\f1001 "
            markupSuffix = "}" markupSuffix

}

// Apply markup prefix and suffix to plain text
richBufferNew += markupPrefix text markupSuffix

}

The above code is from a free DXL utility called "Normalize Rich Text Markup", available from http://galactic-
solutions.com.

http://www.galactic-solutions.com/GalacticDownloads.htm
http://galactic-solutions.com/
http://galactic-solutions.com/
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Rich Text Markup - Normalization in DOORS 6 - Implication:

DOORS 5 - Example of "for rt in s"  loop

DOORS 6 - Example of "for rt in s"  loop

This is a known bug in DOORS 6.x that has been fixed in DOORS 7.

The "Normalize Rich Text Markup" algorithm will still work with this bug, but it will turn this artificial
segmentation into actual segmentation, creating more Rich Text "chunks" than actually necessary.
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Exporting Rich Text to Microsoft Office Applications

The advantage of adopting the Microsoft RTF standard is that formatted text and OLE objects (graphics) can be
easily transferred between DOORS and Microsoft Office Applications (Word, Powerpoint, etc.).

Microsoft Word
DOORS 4.0 thru 5.2 - copying Rich Text to Microsoft Word

string s = richText( o."Object Text" )
setRichClip( richText s, styleName )
oleMethod( objSel, cMethodPaste )

The DOORS setRichClip() function above copies the unprocessed Rich Text Markup string directly from
the Rich Text string variable to the Windows clipboard, with the desired target Style Name .  Then, the Microsoft
Visual Basic for Applications method "Paste" is used to paste the Rich Text Markup into the Word document.

DOORS 4.0 thru 5.2 - Copying OLE Objects to Microsoft Word

If a DOORS Object contains an OLE Object, the DOORS oleCopy()command will copy it to the Windows
clipboard.  It can then be pasted into the Word document using the "Paste" method as described above.

DOORS 6 and above - copying Rich Text to Microsoft Word

string s = richText( o."Object Text" )
setRichClip( richText s )
oleMethod( objRange, cMethodPaste )
olePut( objRange, cPropertyStyle, styleName )

DOORS 6 and above - Copying OLE Objects to Microsoft Word

OLE Objects are now embedded in the RTF stream, so no separate oleCopy() is necessary.
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Microsoft Word - Paragraph vs. Character Style

Styles are the architecture upon which Word is based.  There are two types of styles in Microsoft Word; character
and paragraph.

• A Paragraph Style is a set of pre-defined formatting instructions that you can use repeatedly throughout the
document.

• Character styles can be applied to individual words, or even single characters.

A paragraph style contains both font and paragraph formatting which makes it more comprehensive than a character
style. When you apply a paragraph style the formatting affects the entire paragraph. For example, when you center
text, you cannot center a single word. Instead, the entire paragraph is centered. Other types of paragraph-level
formats that paragraph styles control are: line spacing (single-space, double-space, etc.), text alignment, bullets,
numbers, indents, tabs and borders.

DOORS (v4 and above) rely on embedded Rich Text Markup to specify font effects (bold, italics, etc.), so when
such text is pasted from DOORS and mapped to a Paragraph Style that also controls font markup, conflicts can arise.

For example, export formatted text to Microsoft Word using the "Caption" Paragraph Style built into the
"normal.dot" template.

Formatted text in DOORS, with Paragraph Style
attribute set to export "Object Text" to the "Caption"
Style in Word

Resulting export to Word, showing undesired reversal of
intended font effects.

To avoid this situation, avoid exporting to Paragraph Styles in a Microsoft Word template that set font effects.
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Microsoft Word - Updated DOORS 6 Export to Word

DOORS  "Object Text" with Rich Text Markup (bolded text).

Export to Microsoft Word, using the built-in DOORS 6.0 SR1 "Export to Word".

Resulting output in Microsoft Word, with incorrect Rich Text Format representation (non-bolded text) shown.

This is a known bug in the built-in DOORS 6.x "Export to Word".  Telelogic has provided a fixed version, available
for download at http://support.telelogic.com/en/doors/dxl/

Resulting output in Microsoft Word, with correct Rich Text Format representation (bolded text) shown.

http://support.telelogic.com/en/doors/dxl/
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Export to Microsoft Excel

When Rich Text Format strings are copied from DOORS to an Excel Worksheet Cell, formatting is stripped and the
resulting unformatted text is pasted directly into the cell by Excel.

DXL to paste Rich Text string from DOORS "Object Text" to Excel

string s = richTextNoOle( o.”Object Text” )
olePut( objCell, "Value", s )

Then, using the "for rt in s do" construct described earlier, the desired Rich Text Markup can be rebuilt
in Excel by scanning each segment as stored in DOORS, and duplicating the formatting using Excel Visual Basic for
Applications.

The above code is from a free DXL utility called "Enhanced Export to Excel", available from http://galactic-
solutions.com and presented at the Telelogic Americas 2002 Users Group Conference.

http://www.galactic-solutions.com/downloads/GalacticDownloadExcel.htm
http://galactic-solutions.com/
http://galactic-solutions.com/
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Appendix:

 DOORS 4.1 - Updates

New functions added to the "Rich text functions" section:
string removeUnlistedRichText(string s) Removes rich text markup which DOORS does not recognize.

Recognized markup is: italic, bold, underline, strikethru, font, style.
New functions added to the "Rich text string processing" section:
string stringOf(RTF_string__ richString) allows access to rich text as a string.
RTF_string__ richClip() gets the rich text contents of the system clipboard as a rich text string
void setRichClip(RTF_string__ richString)
void setRichClip(RTF_string__ richString,
string styleName)

Sets the system clipboard to be the rich text string parameter ,
or, can also include a minimal RTF stylesheet that contains a supplied
style name which consequently sets the string style.

bool pasteToEditbox() pastes the contents of the clipboard into an module object that is ready
for in-place editing.
Returns false if paste fails.

New functions added to the "Enhanced character support" section:
int charsetDefault() returns the system default character set.

On UNIX platforms, this will always be charsetAnsi.
On Windows systems, the user's local setting is returned.

charset()
string fontTable(Module mod) returns the module's font table, which is used for mapping richtext

font markup to character set information.
New functions added to the "Importing rich text" section:
importRTF
New "Support Tools" added to the Tools menu of DOORS Formal Modules with the release of DOORS 4.1.
<standard/doctools/normmark.dxl> "Remove Unsupported Markup"
<standard/doctools/delmark.dxl> "Remove All Markup" (Rich Text mark-up Deletion Tool)
<standard/doctools/symbconv.dxl> "Convert Symbols to Text" (Symbol to Plain Text Conversion Tool)

DOORS 5.0 - Minor Updates
string cutRichText(string s, int start,
int end)

Returns the string s with the displayed characters from start to end
removed. For the purposes of counting characters, rich text markup is
ignored, and markup is preserved.

string exportRTFString(string s) Translates a DOORS rich text string to the RTF standard. The only
difference is that tab characters are replaced by \tab and newline
characters are replaced by \newline.
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DOORS 6.0 - Major Update

string exportRTFString(string s) optional arguments added; font information is always included;
newlines are converted into /par tags instead of /newline tags

richtext_identifier returns the object identifier as an RTF string
stripRTFheaders
richTextFragment

returns the content of the passed string with any font color or other
RTF header information removed

richTextWithOle returns rich text of specified attribute, including OLE objects
richTextNoOle returns rich text of specified attribute, excluding OLE objects
richTextWithOle(column) returns the text contained in specified column as rich text, including

OLE objects
richTextNoOle(column) returns the text contained in specified column as rich text, excluding

OLE objects
RichTextParagraph type Data type to handle looping through paragraphs with bullets and

indents
"Support Tools" removed from the Tools menu of DOORS Formal Modules with the release of DOORS 6.0.
<standard/doctools/normmark.dxl> "Remove Unsupported Markup"
<standard/doctools/delmark.dxl> "Remove All Markup" (Rich Text mark-up Deletion Tool)
<standard/doctools/symbconv.dxl> "Convert Symbols to Text" (Symbol to Plain Text Conversion Tool)

 DOORS 7.0 - Minor Update

void useRTFColour(DBE dbe, bool
useRTF)

Use the rtf colour markup instead of the default colour for text in
dialog boxes.

string
applyTextFormattingToParagraph(string s,
bool addBullets, int indentLevel, int
paraNumber)

Applies bullet and/or indent style to the given text, overwriting any
existing bulleting/indenting.

string exportRTFString (sring text [, int
level [, bool isHeading ] ] )

The appropriate font information is included when the supplied plain
string text is rendered as rich text.

string richTextFragment(string richString)
string richTextFragment(string richString,
string fontTable)

Returns an equivalent representation of the rich text with rtf header
information removed.
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References:

Microsoft Corporation Rich Text Format (RTF) Specification, version 1.6
(http://msdn.microsoft.com/library/default.asp?url=/library/en-us/dnrtfspec/html/rtfspec.asp)

Microsoft Corporation RTF Specification to Word 97 (RTF version 1.4 or later
(http://download.microsoft.com/download/word97win/spec2/1/WIN98/EN-US/GC1282.exe)

Microsoft Corporation Rich-Text Format (RTF) Specification, version 1.0
(http://www.nist.fss.ru/hr/doc/spec/rtf1.htm) or (http://www.nwsta.com/Soft/ntd/spec/rtf1.php)

Obtaining Software:

DOORS Users are encouraged to obtain, use, share, and improve upon the utilities mentioned in
this presentation.

For a free copy:

Contact:  michael@galactic-solutions.com, or download from http://galactic-solutions.com.

http://msdn.microsoft.com/library/default.asp?url=/library/en-us/dnrtfspec/html/rtfspec.asp
http://download.microsoft.com/download/word97win/spec2/1/WIN98/EN-US/GC1282.exe
http://www.nist.fss.ru/hr/doc/spec/rtf1.htm
mailto:michael@galactic-solutions.com
http://galactic-solutions.com/#http://galactic-solutions.com

	DOORS Rich Text - Behind the Markup
	DOORS 4.0 - Introduction of Rich Text
	Rich Text Markup - Overview
	Rich Text Markup - DOORS 4 and above
	DXL to set and display Rich Text strings – DOORS 4 thru 5
	DOORS 4.1 - Updates
	DOORS 5.0 - Minor Updates
	DOORS 6.0 - Major Update
	DXL to set and display Rich Text string – DOORS 6
	DOORS 6 – Setting Rich Text from the DOORS Graphical User Interface (GUI).
	Rich Text Markup - DOORS 6 and above

	Detailed explanation of Microsoft Rich Text Markup
	Rich Text Markup - Font Effects in DOORS 6
	Rich Text Markup - New Font Effects in DOORS 6
	DOORS 6 - Rich Text Markup for Bullets
	DOORS 6 - Rich Text Markup for Indents
	DOORS 6 - Rich Text Markup for OLE Objects

	Application - Rich Text Markup and Layout DXL - Setup
	Application - Rich Text Markup and Layout DXL - Results
	�DOORS Font Table - Module Level Attribute
	Rich Text and Importing from Microsoft Office Applications
	Rich Text Markup - Normalization in DOORS 6
	The requirements for the desired normalization are:
	All Font Markup shall be eliminated for Object Heading and Object Text Attributes, except:
	(2)  Valid Rich Text Markup (bold, italic, strikethru, underline, superscript, subscript) shall be preserved.
	Object Text with embedded OLE, bullet, or indent markup (new features in DOORS 6) shall not be modified.
	Rich Text Markup - Normalization in DOORS 6 - Algorithm:
	Rich Text Markup - Normalization in DOORS 6 - Implication:
	Exporting Rich Text to Microsoft Office Applications
	Microsoft Word
	Microsoft Word - Paragraph vs. Character Style
	Microsoft Word - Updated DOORS 6 Export to Word
	Export to Microsoft Excel


	Appendix:
	
	DOORS 4.1 - Updates
	DOORS 5.0 - Minor Updates


	References:
	Obtaining Software:

